KODAK Gel Logic 100 System

User's Guide
# Table of Contents

## Introduction ............................................. 1-1
- About the User’s Guide ...................................... 1-2
- Conventions .............................................. 1-2
- Navigating Through the User’s Guide ....................... 1-3
- Package Contents ........................................ 1-4
- System Requirements .................................... 1-5
  - Minimum System Requirements—Windows ............... 1-5
  - Minimum System Requirements—Macintosh ............ 1-5
- Technical Support ....................................... 1-6
  - Kodak Molecular Imaging Systems Technical Support 1-6
- Registering your System ................................ 1-7

## System Overview ......................................... 2-1
- The KODAK Gel Logic 100 Hardware Overview ............ 2-2
  - The GL 100 Camera Assembly ............................ 2-2
  - The GL 100 Imaging Cabinet ............................ 2-4
- The KODAK Gel Logic 100 Window ........................ 2-6
  - The Image Preview ..................................... 2-7
  - User Section of the GL 100 Window ..................... 2-8
  - Exposure Section of the GL 100 Window—Standard Exposure(s) 2-10
  - Exposure Section of the GL 100 Window—Time Lapse Exposures 2-13
  - The Zoom Setting Section of the GL 100 Window ..... 2-14
  - The Buttons Section of the GL 100 Window .......... 2-15
  - The GL 100 Preferences Dialog box ................... 2-16

## Setting Up Your System .................................. 3-1
- Setting Up the Hardware ................................ 3-2
- Installing KODAK Software—Windows ...................... 3-3
  - Uninstalling a Previous Version of KODAK MI or KODAK 1D Software—Windows ... 3-4
Capturing Images .............................................. 4-1

Maintaining Your System ................................. 5-1

Copy Protection Device Installation ............................... 3-8
Setting Windows Power Settings ............................. 3-9
DirectX 8.1 Runtime Installation (Windows 2000 Users) ........ 3-9
Connecting the Gel Logic Camera to Your IEEE 1394 (FireWire) Port—Windows ... 3-10
Installing KODAK Software—Macintosh ...................... 3-11
Uninstalling a Previous Version of KODAK MI or KODAK 1D Software—Macintosh. 3-11
KODAK Molecular Imaging Software Installation—Macintosh .......... 3-13
Copy Protection Device Installation .......................... 3-14
Setting Macintosh Power Settings ............................ 3-15
Connecting the Gel Logic Camera to Your IEEE 1394 (FireWire) Port—Macintosh 3-16
Launching KODAK Molecular Imaging Software for the First Time ........ 3-17
KODAK MI Security Manager ................................. 3-19
Launching KODAK Molecular Imaging Software with your GL 100 System ... 3-23
Troubleshooting the System ........................................... 6-1
  Technical Support ...................................................... 6-2
  Kodak Molecular Imaging Systems Technical Support ............ 6-2
  Common Instrument Questions ....................................... 6-3
  Common Image Questions ............................................. 6-4
  Common Software Questions ......................................... 6-5

Warranty ................................................................. W-1
  Warranty Time Period .................................................. W-1
  Days and Hours of Coverage ........................................... W-1
  Warranty Repair Coverage ............................................ W-1
  Limitations .................................................................. W-2
  How to Obtain Service .................................................. W-3
  General Instructions for Cleaning and Decontamination For Return of the KODAK Gel Logic 100 .................................................. W-4
  Regulatory Information .................................................. W-6
Introduction

Thank you for purchasing the KODAK Gel Logic 100 Imaging System (GL 100). The GL 100, in combination with KODAK Molecular Imaging Software (KODAK MI Software), is specially designed for gel documentation and analysis. The IEEE 1394 (FireWire) mega pixel CCD camera provides real time imaging for increased throughput in your laboratory. The scientific grade CCD provides an 10-bit -data file which can be accumulated up to 14-bit image files for improved sensitivity and data accuracy.

The GL 100 Acquire Software module, running within KODAK MI allows you to:

✔ Image electrophoresis gels, microtiter plates, and colony and plaque assays.
✔ Analyze your image for molecular weight, mass, optical density, and intensity measurements.
✔ Annotate and prepare your images for publication.
✔ Database images and employ an advanced search strategy to locate and open a specific stored project.
✔ Generate hard copy prints at a fraction of the cost of instant photography.
✔ Easily share or transmit image files over local or worldwide networks.

Molecular Imaging Systems, Eastman Kodak Company is dedicated to providing cutting edge imaging product systems for scientific research applications. For more information on Kodak products for scientific imaging applications, please visit us on the worldwide web at http://www.kodak.com/go/scientific.
About the User’s Guide

The KODAK Gel Logic 100 User’s Guide provides you with all of the information you need to capture images. It is designed to be used in conjunction with the KODAK Molecular Imaging Software User’s Guide.

If you are like most users, you will want to get started right away; but before you do, you need to have basic computer skills including:

✔ Launching applications.
✔ Using a mouse.
✔ Using pop-up menus.
✔ Selecting and editing text.
✔ Saving and printing your work.
✔ Dragging and dropping objects.

Refer to your computer manual to become familiar with the skills listed above.

Conventions

This User’s Guide utilizes the following conventions:

✔ Menus and dialog boxes are displayed using Windows 2000 and may appear differently on your screen. Any significant differences in commands between Macintosh and Windows platforms are noted in the text.

✔ Menu commands, tool names, and window names are shown capitalized.

✔ Warnings, tips, and notes appear in the text like this:

☞ NOTE: Kodak Molecular Imaging Systems provides maximum performance products for scientific imaging.

✔ Important safety warnings appear in the text as follows:

⚠️ WARNING: This symbol is used in the User’s Guide to designate a warning or caution statement.

⚠️ WARNING: This symbol is used in the User’s Guide to designate where electrical shock is possible.
Navigating Through the User’s Guide

The KODAK Gel Logic 100 Imaging System User’s Guide is divided into the chapters listed below:

✔ Chapter 1: *Introduction* gets you started by describing system components and requirements.

✔ Chapter 2: *System Overview* details the instrument and software related to GL100.

✔ Chapter 3: *Setting Up Your System* describes how to set up your GL 100 with the GL 100 accessories required for gel photography.

✔ Chapter 4: *Capturing Images* describes how to image electrophoresis gels using the GL 100 mounted on the GL 100 Imaging Cabinet.

✔ Chapter 5: *Maintaining Your System* describes how to care for and maintain your GL 100.

✔ Chapter 6: *Troubleshooting* offers tips if you encounter any problems with your system.

✔ *Warranty* reviews the warranty and repair coverage provided by Eastman Kodak Company.
Package Contents

When unpacking your GL 100, please take a moment to ensure that all the necessary parts have been received. Your package should contain:

**KODAK Gel Logic 100 Image Capture Hardware(1)**
- ✔ GL 100 Camera Assembly
- ✔ GL 100 Imaging Cabinet
- ✔ Camera/Computer Interface Cable
- ✔ 52 mm 590 nm Filter
- ✔ Gel Framing Mask Kit
- ✔ GL 100 User’s Guide

**KODAK Molecular Imaging Software (1)**
- ✔ Molecular Imaging Software CD
- ✔ User’s Guide
- ✔ Copy Protection Devices (2)
- ✔ User’s Registration Card
  (or)
- ✔ KODAK Molecular Imaging Software Network Edition (Custom Package)
  - Molecular Imaging Software Network Edition CD (1)
  - Molecular Imaging Software Network Edition Administrator’s Manual (1)
  - Molecular Imaging Software User’s Guides (3)
System Requirements

These are minimum specifications, however, we cannot ensure that all hardware and software systems are compatible. For optimal performance, we strongly recommend dedicating a computer exclusively for use with your imaging system.

Minimum System Requirements—Windows

✔ Pentium IV (or equivalent) processor greater than 1 GHz, greater than 2 GHz is recommended
✔ Personal computer with a IEEE 1394 (FireWire) and a USB port
✔ Windows 2000 (Service Pack 4 or greater) or Windows XP (Service Pack 2 or greater) operating system software

☞ NOTE: Check your operating system version by right-clicking on the My Computer icon and then on Properties
✔ CD drive
✔ Minimum 1 GB of available RAM, 2 GB recommended
✔ Minimum 10 GB of available hard disk space
✔ 17 in. display—1280 x 1024 resolution

Minimum System Requirements—Macintosh

✔ Macintosh Power PC G4 processor or better
✔ Personal computer with a IEEE 1394 (FireWire) and a USB port
✔ Mac OS 10.3.8 or greater

☞ NOTE: Check your operating system version by selecting About This Mac under the Apple menu item.
✔ 17 in. display—1280 x 1024 resolution
✔ Minimum 1 GB of available RAM, 2 GB recommended
✔ Minimum of 10 GB of available hard disk space
✔ CD drive, CD-RW drive recommended
Technical Support

Contact Kodak Technical Support or your Molecular Imaging Systems dealer. For up to date dealer information, visit our WEB site at www.kodak.com/go/scientific. When contacting technical support, please have the following information available:

✔ The serial number and version number of your KODAK Software.

NOTE: With the software running, select About KODAK MI under the Help menu (Windows) or select About KODAK MI under the Apple menu item (Macintosh).

✔ The type of computer you are using (make, model and operating system version).

NOTE: Check your operating system version by right-clicking on the My Computer icon and then on Properties (Windows) or select About This Mac under the Apple menu item (Macintosh).

✔ The problem you are having and what you were doing when the problem occurred. Please note the exact wording of any error messages, including any error numbers displayed.

When contacting technical support by telephone, you will be assisted best if you are seated in front of your computer with KODAK MI Software running.

Kodak Molecular Imaging Systems Technical Support

Contact Kodak Molecular Imaging Systems Technical Support by:

✔ Utilizing our World Wide Web support pages at:
  http://www.kodak.com/go/scientific

✔ Calling Kodak Molecular Imaging Systems Technical Support toll free at:
  877-747-4357, between the hours of 8:00 a.m. and 6:00 p.m. (Eastern Standard Time) Monday through Friday

✔ E-mailing Kodak Molecular Imaging Systems Technical Support at:
  kmi-support@kodak.com

✔ Faxing Kodak Molecular Imaging Systems Technical Support at:
  203-786-5656
Registering your System

It is important for you to register your KODAK system. Once registered, you will receive information on maintenance releases, upgrades, and exciting new products from Kodak. Register by filling out and returning the registration card included with your software package.

You can also register any time on-line. If your computer connects to the Internet, select Register MI from the Help menu (Windows) or Register Online from the Apple menu item (Macintosh).
System Overview

The GL 100 supports a wide variety of image capture methods including single capture exposure, multiple capture exposure (accumulated into a single file or as separate files), and time lapse exposures. Using these exposure modes, the minimum and maximum exposure times are 0.001 second and 16 seconds, respectively.

✔ Single Exposure takes one 10-bit image. After capture, the image file automatically opens as a project.

✔ Multiple Exposure (Final Accumulation) adds successive captures into a single accumulated image. The maximum number of images accumulated is 32 generating up to a 14-bit image file. The final accumulated image is automatically opened as a project.

These accumulated images expand the dynamic range of signal you can capture for more quantitative accuracy while also improving detection sensitivity.

✔ Time Lapse Exposure provides exposures at set intervals. You can set the exposure time, the time lapse interval, the total exposure time, and the total number of images. The maximum duration time is 200 hours. The maximum number of images that may be captured is 100. Each file is automatically saved to your hard drive.

This section provides an overview of the KODAK Gel Logic 100 Imaging System (GL 100). You will review the principles of operation and get a better understanding of the critical components—the GL 100 Digital CCD Camera Assembly, the GL 100 Imaging Cabinet with accessories, and the KODAK GL 100 Acquire Software.
The KODAK Gel Logic 100 Hardware Overview

The GL 100 has two main parts—the GL 100 Camera Assembly and the GL 100 Imaging Cabinet. Let’s review.

✔ The *Camera Assembly* contains the CCD camera and lensing system. This assembly is designed as a single serviceable part.

✔ The *Imaging Cabinet* maintains the proper focal length (distance between sample and camera), while blocking out ambient light. The cabinet accommodates samples up to 20 x 27.5 cm.

The GL 100 Camera Assembly

The GL 100 Camera Assembly has been custom designed to provide optimal dynamic range, sensitivity, field of view, and real time imaging of gel electrophoresis images. You can manually adjust the focus, zoom, or aperture (f-stop) settings of the lens.
A The Camera Cable Connector (not shown) couples the GL 100 camera to the computer with a special Camera/Computer Interface Cable. This cable also provides power to the camera.

⚠️ WARNING: Use only the provided Camera/Computer Interface Cable to attach the GL 100 to your computer.

⚠️ WARNING: Be sure to orient the camera cable connector properly with the narrow end pointing down to avoid damage to the circuitry and voiding the warranty.

⚠️ WARNING: We recommend connecting the GL 100 as the only device on the IEEE 1394 (FireWire) bus.

B The Lens provides f-stops settings from f1.2 to closed and zoom settings from 8 to 48 mm.
C The f-Stop Ring regulates the amount of light reaching lens for an exposure. At f-stop 1.2, the maximum amount of light is passed through the lens.
D The Zoom Ring is a 6 X lensing system that adjusts the field of view setting of the lens from 3.5 x 4.7 cm (272 pixel/cm) to 20 x 27.5 cm (46 pixel/cm).
E The Focus Ring adjusts the focus of the lens.
The GL 100 Imaging Cabinet

The GL 100 Imaging Cabinet maintains an optimum focal length (distance between sample and camera) that minimizes focusing between zoom settings, while blocking out ambient light. The GL 100 Camera Assembly is mounted to the top of the imaging cabinet. The convenient built in Filter slider accommodates 52 mm filters.

A The GL100 Camera Assembly is mounted to the top of the imaging cabinet.
B The Handles (not shown) provide a convenient grip to move the system when switching light sources or when working with large samples.
C The Imaging Cabinet Door accesses the area under the camera, which accommodates samples up to 20 x 27.5 cm.
D The Filter slider facilitates the use of filters. The Active Location Indicator Slot designates the position that is under the lens. Two additional slots are provided for convenient storage of filters not in use. A 590 nm filter is included in the package. It is especially designed to eliminate light other than 590 nm wavelength produced by ethidium bromide (or other similar emission wavelength) stained samples. Additional optional filters are also available.
The Framing Masks (not shown) accurately frame samples in the camera’s field of view. The three masks span common sample sizes. They also help to minimize your exposure to UV light by blocking the area outside the imaging cabinet.
The KODAK Gel Logic 100 Window

The Gel Logic 100 window is accessed from within KODAK MI Software. Choose Select Digital Camera from the File menu and GL 100 from the Digital Camera pop-up menu. The Gel Logic 100 window appears. This window is divided into five sections. Let's review each section.

A The Image Preview window displays continuous-successive “live” captures when in Preview mode.
B The User section contains options to apply predefined settings, record your name, and add annotations on the image.
C The Exposure section allows you to select the various exposure options necessary to capture images.
D The Zoom Setting section records the position of the camera zoom lens just prior to image capture.
E The Buttons section contains the Preview, Capture, Preferences, Quick Print and Done buttons, and the Progress bar and Elapsed Time text boxes, used to navigate through an image capture.
The Image Preview

The Preview button initiates the “live” stream of single capture images in the Image Preview window. The Progress bar and Elapsed Time text box become active and provide feedback on the current capture.

Preview is used primarily for optimizing your capture conditions including sample placement, aperture, zoom, and exposure time. While previewing a capture, the focus options are accessible (see Using the Focus Tool in Chapter 4: Capturing Images).

NOTE: If you have selected a rotation preference, the preview will not reflect the rotation setting. The rotations are performed upon image capture and display in the Project window.

The preview will continuously take and display images at a frame rate of up to 7 frames per second until you click the Stop Preview button. At any time you can initiate an image capture by clicking the Capture or Quick Print button.

✔ The Capture button capture an image subject to the user, exposure, and zoom settings. The image is opens as a new project.

✔ The Quick Print button sends the captured image directly to the default printer without saving to disk.
User Section of the GL 100 Window

The User section of the GL 100 window contains the Custom Settings, User Name, and Annotation options. Let’s review each option:

![Custom Settings Menu]

**Custom Settings**

You can speed up the capture process by creating custom capture settings for the various types of experiments or for specific personal preferences. Once saved, these settings can be conveniently applied to future image captures.

You can make modifications to the custom settings (i.e., change exposure time) or delete a setting using the Update Settings or Delete Settings option. The Custom Settings pop-up menu also contains a number of factory-defined settings useful for common laboratory imaging applications.

Saved settings include:

- ✔ Type
- ✔ Exposure time
- ✔ Number of exposures
- ✔ Illumination correction
- ✔ Zoom settings
- ✔ Image orientation
- ✔ Preferences selections
- ✔ Saturation levels

⚠️ NOTE: The Settings option does not save the user name or annotations.

⚠️ NOTE: Custom settings will be saved as individual files in the
MacintoshHD>Applications>KODAK MI>Kodak MI Extensions>GL
100_Settings (Macintosh) or C: Program Files>Kodak MI>MI
Application>GL_100>GL_100 Settings (Windows) subfolders.
**System Overview**

**User Name**

<table>
<thead>
<tr>
<th>User Name:</th>
<th>Hannah</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acct User</td>
<td></td>
</tr>
<tr>
<td>Delete User</td>
<td></td>
</tr>
<tr>
<td>Chester</td>
<td></td>
</tr>
<tr>
<td>Luther</td>
<td></td>
</tr>
<tr>
<td>Hannah</td>
<td></td>
</tr>
</tbody>
</table>

Use the User Name text edit box to type in your name. To save your name for future experiments, choose Add User from the pop-up menu. The name appears in the menu. Names can be deleted in the same manner by choosing Delete User.

**Annotations**

You can tag your image with an Annotation bar with up to 48 characters of text. In addition, the Annotation bar lists the time and date of the image capture, the exposure time, and the illumination source. The text appears on the long axis at the top of the page.

All items in the Annotation bar are separate objects and can be displayed in the Annotation window. This allows you to edit the text, change the font style, color, or size prior to printing. The contents are grouped, therefore, you must ungroup these objects prior to editing.

- **NOTE:** Each time you capture an image, the Annotations text edit box is cleared. Annotations are not saved with Custom Settings.

- **NOTE:** Display or hide the Annotation bar by selecting the Add Annotation bar from within the Annotation panel.
Exposure Section of the GL 100 Window—Standard Exposure(s)

You can define the exposure parameters using the Exposure section of the GL 100 window. Select the type of exposure, exposure time, whether you want saturated pixels to displayed in red on screen, and whether to perform an illumination correction.

![Exposure Setting Section]

After selecting the type of exposures you want to take from the Type pop-up menu, the exposure setting section updates with the appropriate text and check boxes for that type of capture.

- **UV Transillumination** is ideal for providing illumination for fluorescently stained images (i.e., ethidium bromide, SYBR green). The imaging cabinet is designed to be placed on top of a standard size UV transilluminator. The GL 100 can image up to a 20 x 27.5 cm area.

- **White Light Transillumination** is also ideal for opaque samples (plates and visible dye stained gels). The imaging cabinet is designed to be placed on top of a standard size white light table.

- The **Time Lapse Exposure** option is designed to take multiple exposures over fixed time intervals.

- The **Custom** option allows you to define your own type.
The Exposure Text Edit Box

The Exposure Time text edit box defines the exposure. The minimum and maximum exposure times are 0.001 second per exposure and 16 seconds per exposure, respectively. The time units can be set as seconds or minutes. The minimum increment is 0.001 second for short exposures.

The No. Exposure Text Edit Box/Pop-up Menu

You can accumulate up to 32 captures into a single image. The Accumulation option is designed to accumulate the intensity information from multiple exposures and generate an accumulation image as a single project. This is especially useful when you have faint signal. You select the number of exposure by typing in a value or by selecting one of the predefined options from the pop-up menu.

The Expt Duration Text Box

The Expt Duration indicates the total capture duration in hours. The software will automatically calculate the total duration of the exposure based on the number of exposures and the time of each exposure.

Show Saturation Checkbox

Click the Show Saturation checkbox to turn image pixels turn red when the saturation level. Saturated pixels adversely affect the quality of your image analysis since the signal reading do not accurately measure intensity. Use this option to aid you in selecting the ideal exposure conditions (f-stop and exposure time).
Illumination Correction Checkbox

Use the Apply Illumination Correction to check box to generate and apply an illumination correction. To correct for uneven illumination and improve the quality of your data, an illumination reference can be used. The nonuniformity in the illumination generated by the UV bulbs or white light is highly reproducible and may be corrected by simply dividing the image by an illumination reference image. The exposure settings used to capture the image must match those used to create an illumination reference image.
Exposure Section of the GL 100 Window—Time Lapse Exposures

The TimeLapse option is designed to take multiple exposures over fixed time intervals. For example, you may want to take a 10 second exposure every hour over the next day. You can set the exposure time, the time lapse interval, the total exposure time, and the total number of images.

✔ The *Exposure Time* defines the exposure. The minimum and maximum exposure times are 0.001 seconds per frame and 100 minutes per frame, respectively. The time units can be set as seconds or minutes. The maximum duration time is 200 hours. The minimal increment is 0.001 second.

✔ The *Interval* is the time interval between the beginning of one exposure and the beginning of the next exposure. The minimum and maximum intervals are 5 seconds and 24 hours, respectively.

✔ *Stop After* determines when to stop time lapse captures. You can set stop criteria based on experimental duration or by the number of frames.
The Zoom Setting Section of the GL 100 Window

The Zoom Setting section of the GL 100 window allows you to enter information about the capture settings used. Documenting this information is critical, since this data is used to perform illumination field flattening and to optimize the image for display and analysis. In addition, these settings are recorded in the History tab of the File Information window and can be used as a reference for similar type experiments.

✔️ The Zoom (mm) slider records the field of view to the corresponding setting on your GL 100 Digital CCD camera.

⚠️ NOTE: The Zoom slider does not adjust the lens, it only records the current lens setting.
The Buttons Section of the GL 100 Window

The Buttons section of the GL 100 window is used to navigate through an image capture.

- ✔ The *Preview* button initiates continuous/ succesive “live” captures when in Preview mode.
- ✔ The *Stop Preview* button.
- ✔ The *Capture* button begins the image capture.
- ✔ The *Quick Print* button sends the image directly to your printer and no copy of the image is saved.
- ✔ *Focus (only available in preview mode)* checkbox accesses the software-assisted focus protocol.
- ✔ The *Preferences* button opens the GL 100 Preferences window where you can customize certain capture parameters. The GL 100 Preferences window is described in more detail later in this chapter.
- ✔ The *Done* button closes the GL 100 window and returns you to KODAK MI Project window.
The GL 100 Preferences Dialog Box

You can choose a variety of options using the GL 100 Preferences dialog box. Let’s review the dialog box options:

The Preferences dialog box is divided into two sections: Image Capture and Print Preferences.
Image Capture Preferences

The Image Capture Preferences allows you to select:

✔ *Submit Rotated*—provides the option of automatically rotating a newly captured image to a desired orientation, as they are downloaded from the camera.

**Rotate:**

- ![R](R) The image is in the default orientation.
- ![α](α) Rotate the image 90° counterclockwise.
- ![R](R) Rotate the image 180°.
- ![R](R) Rotate the image 90° clockwise.

**NOTE:** The Rotation buttons do not change the orientation of the preview image. The rotation occurs during submission of the image to the Project window.

**NOTE:** Rotation events are documented in the History tab of the File Info, since rotations are destructive to the original data file.

✔ *Options*—You can choose to open images after capture in either the Analysis window or Annotation window.

**Camera Delay**—configures the GL 100 camera to take a picture with 5 or 10 second delay. This delay occurs after the capture command is executed and before the actual picture is taken. Choose the time in the Camera Delay pop-up menu.

**NOTE:** This option is useful in situations when light tables take several seconds to become completely illuminated.
**Print Preferences**

The Quick Print feature is used when a printed copy is all that you require. When you click Quick Print, an image is captured and sent directly to your printer. The Printing Preferences allows you to control the various print options from within the GL 100 window.

✔ The Options pop-up menu allows you to select:

- **Print immediately** bypasses the standard Print dialog box and immediately prints the image on the current default printer. Once printed, the file is deleted.

- **Open print dialog box** opens the Print dialog box where you can select print parameters. Once printed, the file is deleted.

The **Print Image Size** sets the image size. By default, the image is printed at **Actual Size (1X)**. Alternatively, choose an image size of **3 x 5 in**, **4 x 6 in**, **5 x 7 in** or **Full Page**.

Click **OK** when you have finished setting your preferences.
Setting Up Your System

In this chapter you will learn how to set up your system so that you can begin taking pictures.

✔ The GL 100 digital CCD camera provides mega pixel resolution that allows you to detect resolve closely spaced bands. In addition, the scientific grade sensor can integrate frames provides outstanding dynamic range and increase sensitivity.

✔ The GL 100 window is integrated into KODAK MI Software and controls the camera during image capture and prints. Once acquired, images can be analyzed, annotated, and saved.

✔ The GL 100 Imaging Cabinet maintains the optimal focal length (distance between sample and camera), while blocking out ambient light.

✔ The GL 100 zoom lens achieves proper focus and field of view for gels ranging from 3.5 x 4.7 cm to 20 x 27.5 cm.

✔ The 590 nm filter is specially designed to eliminate light other than 590 nm wavelength produced by ethidium bromide (or other similar emission wavelength) stained samples. It permits maximum sample detection sensitivity by minimizing background. Kodak offers additional filters that are suited for a variety of imaging needs.

✔ The flexible neoprene rubber Framing Masks are designed to accurately frame samples while protecting you from excessive UV exposure while ensuring a tight seal between your light table and the imaging cabinet. Three masks are provided, spanning the typical gel sizes available.
Setting Up the Hardware

The GL 100 comes equipped with the GL 100 Imaging Cabinet, which has been designed to eliminate the need to take pictures in a darkroom. Setting up your hardware should only take a few moments. So let’s begin.

1 Place the largest Framing Mask on top of your UV or white light box. The smaller masks fit nested inside the largest mask and should be used, when necessary, to properly frame the gel.

2 Position the GL 100 Imaging Cabinet on top of the light box such that it is approximately centered on the largest mat.

3 Remove the three retaining nuts from the top of the GL 100 Imaging Cabinet.

4 Position the 3 holes in the GL 100 Camera Assembly over the 3 posts on the GL 100 Imaging Cabinet, while carefully aligning the lens to fit into the nested opening.

5 Check the lens for perpendicular alignment relative to the top surface of the imaging cabinet. No further adjustment should be necessary.

6 Secure the Camera Assembly by tightening the retaining nuts.

WARNING: Do not plug the Camera/Computer Interface Cable into the computer at this time. The GL 100 should not be connected to the computer during software installation (See Installing KODAK Software—Windows or Installing KODAK Software—Macintosh, later in this chapter).
7 Position any filters you received in the storage slots provided on the Filter Slider to protect them from damage. The 590 nm Filter is the only filter provided with the GL 100 package. For information about other filters, contact your local Kodak Scientific Imaging Systems dealer.

NOTE: When imaging, position the appropriate filter in the Active Location slot on the Filter slider.

The table below defines the appropriate filter for many common stains and dyes:

<table>
<thead>
<tr>
<th>Filter (nm)</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>NONE</td>
<td>coomassie gels, autorad film</td>
</tr>
<tr>
<td>670</td>
<td>acrydine orange-RNA</td>
</tr>
<tr>
<td>590</td>
<td>ethidium bromide, ruby red, texas red, ruby orange</td>
</tr>
<tr>
<td>570</td>
<td>Pyronin Y</td>
</tr>
<tr>
<td>535</td>
<td>SYBR Gold, SYBR Green, Fluorescein, Rhodamine, Eosin, acrydine orange-DNA</td>
</tr>
<tr>
<td>435</td>
<td>DAPI, syto blue</td>
</tr>
</tbody>
</table>

8 Close the Filter Slider.

9 Proceed to *Installing KODAK Software—Windows* or *Installing KODAK Software—Macintosh* later in this chapter.
Installing KODAK Software—Windows

Any prior versions of KODAK and/or camera software that are loaded on the computer must be uninstalled prior to installation. If you are a new user, proceed to KODAK Molecular Imaging Software Installation—Windows. Windows 2000 and Windows XP installations require administrator privileges.

NOTE: If you have purchased the KODAK Molecular Imaging Software Network Edition Package, follow the installation procedures as illustrated in the KODAK Molecular Imaging Software Network Edition Administrator's Manual.

Uninstalling a Previous Version of KODAK MI or KODAK 1D Software—Windows

1. Remove your KODAK MI or 1D copy protection device from your computer.
2. Inactivate any virus protection software.

NOTE: Norton Utilities and Norton Antivirus software must be deactivated before you uninstall the KODAK Software. The software might not uninstall properly with the virus protection left active. After installation, you can restart your virus protection software.

3. Close all software applications that may be running on your computer.

NOTE: KODAK cameras should not be connected to the computer while uninstalling the software.

4. Move any customized standards or templates and any projects from their respective subfolders in your existing KODAK MI or KODAK 1D X.X folder to a temporary folder outside the KODAK MI or KODAK 1D folders.

NOTE: If you are currently using the KODAK MI database, also move the database folder as described in the next section entitled Moving your KODAK MI Database—Windows.

5. Uninstall previous version(s) of KODAK MI or KODAK 1D Software.

✔ Uninstall KODAK MI by choosing Control Panel from the Start menu and Add/Remove Programs. Scroll to locate KODAK MI and click the Remove button. You can also uninstall the application using your KODAK MI CD. The InstallShield Wizard automatically detects that you have the software loaded and offers an uninstall option.
Setting Up

✔ Uninstall KODAK 1D by choosing Programs from the Start menu and selecting Remove KODAK 1D X.X from the KODAK 1D X.X submenu.

6 Uninstall additional KODAK Software by choosing Control Panel from the Start menu and Add/Remove Programs. Scroll to locate Sentinel System Driver. Click to select.

7 Click the Add/Remove button and follow the on screen instructions to uninstall.

☞ NOTE: Windows 2000 users may receive a warning message(s) informing you that some of the files you are removing are shared by other programs. Click Yes to remove all the files.

☞ NOTE: Automated uninstall features on some systems may not remove all previous program elements. Check drives for residual folders and files. Manual deletion of these folders and files may be necessary.

8 Restart your computer.

9 Proceed to KODAK Molecular Imaging Software Installation—Windows.

Moving your KODAK Molecular Imaging Database—Windows

1 Backup any saved images.

2 Right-click on My Computer from the Start menu and select Manage.

3 The Computer Management menu appears. Select Services from the Services and Applications.

4 Scroll down to KODAK MI Database and right-click on the icon. Select Stop. Alternately, click the KODAK MI Database icon and Select Stop the service.

5 Move the GMPDB folder from KODAK MI folder and the KodakAdminPortal subfolder to a location outside the KODAK MI folder.

6 Proceed to Uninstalling a Previous Version of KODAK MI or KODAK 1D Software—Windows to uninstall your KODAK MI software and then proceed to KODAK Molecular Imaging Software Installation—Windows to install KODAK MI Software.

7 Following installation of the new KODAK MI Software and restarting your computer, stop the KODAK MI Database process, as described above in Steps 2 through 4. Do not close the Services window.

8 Click the My Computer icon and locate the newly installed GMPDB folder from the KODAK MI folder and the KodakAdminPortal subfolder. Drag the GMPDB folder to the Recycle Bin and empty the Recycle Bin.
9  Move the old GMPDB folder back in the KodakAdminPortal folder.

10 Restart the KODAK MI Database by right clicking on the icon in the Services window and selecting Start.

11 Restart your computer.

☞ NOTE: To retain full functionality of the KODAK MI Database feature, make sure to return your MI projects and images back to their original locations.

12 Proceed to KODAK Molecular Imaging Software Installation—Windows.
KODAK Molecular Imaging Software Installation—Windows

KODAK Molecular Imaging Software is installed like most Windows application programs. Windows 2000 and Windows XP installations require administrator privileges.

1 Inactivate any virus protection software.

☞ NOTE: Norton Utilities and Norton Antivirus Software must be deactivated before you install the KODAK Software. The installation might not run properly with the virus protection left active. After installation, you can restart your virus protection software.

2 Close all software applications that may be running on your computer.

☞ NOTE: Kodak GL 100 should not be connected to the computer while installing the software.

☞ NOTE: Remove any copy protection devices attached to your computer during installation.

3 Insert the KODAK Molecular Imaging Software Version 4.X CD into your CD drive and double-click on the KODAK MI Installer.exe icon to launch the installer.

4 The InstallShield Wizard will lead you through the installation process. Make sure to select the Complete Setup to install the software in the default directory to ensure full functionality of the system.

5 While the software installation is occurring, complete your KODAK Software Registration Card and return the card to Kodak. This ensures that you receive information on new software releases, periodic maintenance releases, and technical bulletins.

6 A dialog box appears when the installation is complete. Select the option to restart the computer and click Finish.

☞ NOTE: Following restart, previous KODAK MI or KODAK 1D users should copy your standards, templates and projects back to their respective subfolders in the KODAK MI folder.

7 Proceed to Copy Protection Device Installation.
Copy Protection Device Installation

KODAK MI Software is copy protected using a device that plugs into the USB port of your computer. It will not launch unless this device is attached to your computer. If you are installing the system for the first time, locate and install the copy protection device according to the instructions below. If you are upgrading your system, your package may or may not contain a new copy protection device.

To install the copy protection device:

1. Plug the copy protection device into a USB port of your computer. Please make sure that the connection is secure.

   - NOTE: Windows XP Users—A Found New Found Hardware Wizard dialog box will appear on screen. You will be asked if you want Windows update to search for software. Click No not at this time and advance through the installation wizard.

   - NOTE: If you are upgrading from a previous version of the KODAK MI or 1D Software and received a new copy protection device, you must attach both the old and new copy protection devices to your computer. After you launch the newest version for the first time, your old copy protection device will be deactivated. Remove and discard the old key.

   - NOTE: If your computer has multiple USB ports, you can plug the copy protection device into any of them. The software, when launched, will check all available USB ports.

2. Proceed to Setting Windows Power Settings.
Setting Windows Power Settings

1 KODAK Imaging Systems require that your computer Energy Saver features be disabled.

2 Click the Power Options icon from the Start menu and the Control Panel.

3 Click Power Schemes tab and select Always On from the Power Schemes pop-up menu.

4 The settings for Turn off monitor, Turn off hard disks, System standby and System hibernates functions become Never.

5 Click OK and proceed to Using KODAK MI Software with KODAK Imaging Systems—Windows.

Direct X 8.1 Runtime Installation (Windows 2000 Users)

To enable the functionality of the Gel Logic camera on your Windows 2000 computer, you must install an accessory Windows component called Direct X version 8.1 Runtime.

1 Inactivate any virus protection software.

   ☞ NOTE: Norton Utilities and Norton Antivirus software must be deactivated before you install the software. The installation might not run properly with the virus protection left active. After installation, you can restart your virus protection software.

2 Close all software applications that may be running on your computer.

3 Insert the KODAK Molecular Imaging Software Version 4.X CD into your CD drive and double-click on the DX81NTeng.exe CD setup in the Camera Installers folder and the Gel Logic Win 2000 ONLY subfolder.

4 The installer leads you through the installation process and prompt you to restart your computer when the installation is complete. Select Yes to restart your computer.

5 Proceed to Connecting the Gel Logic Camera to Your IEEE 1394 (FireWire) Port.
Connecting the Gel Logic Camera to Your IEEE 1394 (FireWire) Port—Windows

Once you have installed KODAK MI Software and your copy protection device, you can connect the GL camera to your computer.

1 Locate the Camera/Computer Interface Cable that is attached to your GL camera. The IEEE 1394 (FireWire) plug has a flat side and a tapered side.

2 Insert the plug into the IEEE 1394 port on your computer. Refer to the figure to properly align the plug with the port.

NOTE: Windows XP Users—A Found New Found Hardware Wizard dialog box will appear on screen. You will be asked if you want the Windows update to search for software. Click No not at this time and advance through the installation wizard.

NOTE: During the installation, a dialog box appears stating Digital Signature Not Found. Click Yes to continue the installation.

3 Click Finish when the wizard is complete.

4 Your installation is complete, proceed to Launching KODAK Molecular Imaging Software for the First Time.
Installing KODAK Software—Macintosh

Any prior versions of KODAK and/or camera software that are loaded on the computer must be uninstalled prior to installation. If you are a new user, proceed to KODAK Molecular Imaging Software Installation—Macintosh. Macintosh OS X installations may require authentication of permissions.

Uninstalling a Previous Version of KODAK MI or KODAK 1D Software—Macintosh

1. Remove your KODAK MI or 1D copy protection device from your computer.
2. Inactivate any virus protection software.

   ☞ NOTE: Norton Utilities and Norton Antivirus software must be deactivated before you uninstall the KODAK Software. The software might not uninstall properly with the virus protection active. After installation, you can restart your virus protection software.

3. Close all software applications that may be running on your computer.

   ☞ NOTE: KODAK cameras should not be connected to the computer while uninstalling the software.

4. Move any customized standards or templates and any projects from their respective subfolders in your existing KODAK MI 4.X or KODAK 1D X.X folder to a temporary folder outside the Kodak folder.

   ☞ NOTE: If you are currently using the KODAK MI database, also move the database folder as described in the next section entitled Moving your KODAK MI Database—Macintosh.

5. Place the KODAK MI 4.X or KODAK 1D X.X folder in the Trash.
6. Select Computer from the Go menu and choose the active hard disk. Locate the KODAK MI.pkg and KODAK MI Admin.pkg in the Library folder and the Receipts subfolder. Move these two files to the Trash.
7. Restart your computer.
8. Empty the Trash.
Moving your KODAK Molecular Imaging Database—Macintosh

1 Backup any saved images.

2 Select Applications from the Go menu and open the Image Database Utilities folder located in the KODAK MI folder and the KodakAdminPortal subfolder. Double-click the Stop Image Database icon.

3 Click Yes to stop the KODAK MI Database process.

4 You may be required to authenticate your Permissions in order to stop the KODAK MI Database process. Enter your User Name and Password and click OK.

5 A message stating Stopping Kodak MI Daemon will appear. Click OK to continue.

6 Move the GMPDB folder from KODAK MI folder and the KodakAdminPortal subfolder to a location outside the KODAK MI folder.

7 Proceed to Uninstalling a Previous Version of KODAK MI or KODAK 1D Software—Macintosh to uninstall your KODAK MI software and then proceed to KODAK Molecular Imaging Software Installation—Macintosh to install KODAK MI Software.

8 Following installation of the new KODAK MI Software and restarting your computer, stop the KODAK MI Database process. Follow Steps 2 through 5 above.

9 Locate the newly installed GMPDB folder from the KODAK MI folder and the KodakAdminPortal subfolder. Drag the GMPDB folder to the Trash.

10 Empty the Trash.

11 Move the old GMPDB folder back in the KodakAdminPortal folder.

12 Select Applications from the Go menu and open the Image Database Utilities folder located in the KODAK MI folder and the KodakAdminPortal subfolder. Double-click the Start Image Database icon.

13 Click Yes to start the KODAK MI Database process.

14 You may be required to authenticate your Permissions in order to start the KODAK MI Database process. Enter your User Name and Password and click OK.

15 A message reading Starting KODAK MI Admin Daemon will appear. Click OK to continue.

Note: Following restart, previous KODAK MI or KODAK 1D users should copy your standards, templates and projects back to their respective subfolders in the KODAK MI folder.
KODAK Molecular Imaging Software Installation—Macintosh

1 Inactivate any virus protection software.

   NOTE: Norton Utilities and Norton Antivirus software must be deactivated before you install the KODAK Software. The installation might not run properly with the virus protection active. After installation, you can restart your virus protection software.

2 Close all software applications that might be running on your computer.

   NOTE: KODAK cameras should not be connected to the computer while installing the software.

3 Insert the KODAK Molecular Imaging Software Version 4.X CD into your CD drive and double-click the KODAK MI.mpkg icon to launch the installer application.

4 The installer will lead you through the installation process. Make sure to install the software in the default directory and ensure full functionality of the system.

5 While the software installation is occurring, complete your KODAK MI Software Registration Card and return the card to Kodak. This process takes only a few minutes to complete and ensures that you receive information regarding new software releases, periodic maintenance releases, and technical bulletins.

6 The installer will notify you when the installation is complete. Click Restart.

   NOTE: Following restart, previous KODAK MI or KODAK 1D users should copy your standards, templates and projects back to their respective subfolders in the KODAK MI folder.

7 Proceed to *Copy Protection Device Installation*. 
Copy Protection Device Installation

KODAK MI Software is copy protected using a device that plugs into the USB port of your computer. KODAK MI will not launch unless this device is attached to your computer. If you are installing the system for the first time, locate and install the copy protection device according to the instructions below. If you are upgrading your system, your package may or may not contain a new copy protection device.

To install the copy protection device:

1. Plug the copy protection device into a USB port of your computer. Please make sure that the connection is secure.

   NOTE: If you are upgrading from a previous version of the KODAK MI or KODAK ID Software and received a new copy protection device, you must attach both the old and new copy protection devices to your computer. After you launch the newest version for the first time, your old copy protection device will be deactivated. Remove and discard the old key.

   NOTE: If your computer has multiple USB ports, you can plug the copy protection device into any of them. The software, when launched, will check all available USB ports.
Setting Macintosh Power Settings

KODAK Imaging Systems require that the Energy Saver settings on your computer be disabled.

To disable the system sleep features


2. Click the Sleep tab and set the Computer and Display sleep sliders to Never. Ensure the Put the hard disk(s) to sleep when possible checkbox is unchecked.

3. Proceed to Connecting the Gel Logic Camera to Your IEEE 1394 (FireWire) Port—Macintosh.
Connecting the Gel Logic Camera to Your IEEE 1394 (FireWire) Port—Macintosh

Once you have installed KODAK MI Software and your copy protection device, you can connect the GL camera to your computer.

1 Locate the Camera/Computer Interface Cable that is attached to your GL camera. The IEEE 1394 (FireWire) plug has a flat side and a tapered side.

2 Insert the plug into the IEEE 1394 port on your computer. Refer to the figure above to properly align the plug with the port.

3 Your installation is complete, proceed to Launching KODAK Molecular Imaging Software for the First Time.

Updating Previously installed KODAK Gel Logic 100 Software

Previous KODAK Gel Logic 100 users must update their camera software for use with KODAK MI Software. Connect your camera as described above in Connecting Your KODAK Gel Logic 100 System.

1 Insert the KODAK Molecular Imaging Software Version 4.X CD into your CD drive and locate the Extras folder.

2 Click the GL Camera Utility icon. A dialog box appears indicating the version of KODAK software currently supported by your camera.

3 Click Initialize to configure the camera for KODAK MI Software Version 4.X. A confirmation message appears on screen.

4 Click OK to exit the installer.

5 Unplug and then reinsert the camera IEEE 1394 plug on your computer to reset your camera software.
Launching KODAK Molecular Imaging Software for the First Time

1 Launch KODAK Molecular Imaging Software.
   ✓ Windows Users—Click Programs from the Start menu and select KODAK MI.exe from the Kodak MI submenu or by double-clicking on the KODAK MI.exe icon found in the C:\Program Files\KODAK MI\MI Application folder.
   ☞ NOTE: Consider placing a Shortcut to the KODAK MI.exe file on your desktop. Navigate to the KODAK MI.exe file as shown above. Right-click on the KODAK MI.exe icon and choose Create Shortcut. A shortcut is created in the MI Application folder. Drag the shortcut to the desktop.
   ✓ Macintosh Users—Select Applications from the Go menu and click the KODAK MI icon found in the KODAK MI folder and the MI Application subfolder.
   ☞ NOTE: Consider placing an Alias to the KODAK MI executable program file on your desktop. To create an Alias, single-click the KODAK MI icon and choose Make Alias from the File menu. An Alias is created in the MI Application folder. Drag the Alias onto the desktop. Alternately, drag the KODAK MI icon to the Dock to create an Alias on the Dock.

2 The KODAK MI Security Setup dialog window appears. You must select either No Login or Login Required from the pop-up menu. Click Continue.

   NOTE: The selected KODAK MI Security feature will apply to your new KODAK MI installation for all users. If you are unsure of your selection, refer to KODAK MI Security Setup, earlier in this chapter for more information.

3 If you selected No Login, you will skip the login procedure and go directly to entering your User Name, Company and KODAK MI Software serial number. Proceed to Step 6.
4 If you selected Login Required, the KODAK MI login window will appear:

![KODAK MI login window]

5 Accept the default Username and enter the default Password. Click Login.

The initial installation of KODAK MI Software comes with a single user with the User Name “Admin” and the Password “password”. Use this User name to gain access to KODAK MI Security Manager to set up users.

6 Type your Name and Organization in the boxes provided.

7 Enter your Serial Number exactly (including dashes) as provided on your registration card or serial number card included in your KODAK MI package.

NOTE: The serial number is required when installing KODAK MI or when contacting Technical Support. Keep the serial number in a safe location.

8 Click OK. The MI Project window appears. Your installation is complete.

NOTE: Previous KODAK MI or 1D users may move any customized standards or templates, any projects, and database folders back into the new KODAK MI folder.

If you selected Login Required when KODAK MI Software was first launched, proceed to setting up User Names and Passwords for each KODAK MI Software user. Proceed to KODAK MI Security Manager, later in this chapter.
KODAK MI Security Manager

KODAK Molecular Imaging Software has two security modes: No Login (No Security) and Login Required (Password Security). When you launch KODAK MI Software for the first time, you are asked which mode you would like to use for this installation.

✔ In No Login Mode—all users will gain access to KODAK MI Software bypassing the login screen

✔ In Password Mode—you will have to enter your User Name and Password every time KODAK MI Software starts up.

NOTE: The initial installation of KODAK MI Software comes with a single user with the User Name “Admin” and the Password “password”. Use this User name to gain access to KODAK MI Security Manager to set up users.

1 Select Database from the Navigation panel and click the Kodak MI Administrator button.

2 Your web browser should launch and display the KODAK MI Administrator Login page.

3 Select the default Username, “Admin”, type the Password “password” (No quotation marks) and click Login.
4 Click the Users button to access the User Administration page, where you can add users. Select Add Users.

![User Administration Page]

5 The User Information page appears. Fill out the information including First Name, Last Name, Username (enter a temporary password), Password, Job Position (Administrator or User), an E-mail address. Click Update.

![User Information Page]

NOTE: Once an actual User has been added, the new User is listed in the User Administration page. The System Administrator (Admin) disappears from the list of users, however, this Username and Password remains as a “back door” access with full administrator privileges.
You may want to take some time to click on the Server Setup button to give your database server a name and specify a SMTP mail server.

- **Server ID**—is a unique name for your machine. The Server ID can either be a name or number.
- **Passwords will expire**—allows administrators to determine how frequently passwords will expire. When a User password expires, they will be required to enter a new password.
- **SMTP Server**—This mail server will be used for sending out E-mails and broadcasting messages. This is a mandatory field that must be entered. The SMTP mail server is required when users click the Forgot Password button.
- **Username**—this is the Username of the administrator. (Optional).
- **Password**—this is a text field where the administrator can enter their password (Optional).
7 An additional feature of KODAK MI Security Manager is the ability to broadcast e-mail messages and to other users. Administrators can enter a subject and message in the fields provided and click Send. If specific users are not check in the User Administration page, all users will receive the broadcast message.

8 Click Logout to exit KODAK MI Security Manager. On the next restart of KODAK MI software, users must select their Username, type their old password and enter a new password. Upon logon, the User’s password updates.
Launching KODAK Molecular Imaging Software with your GL 100 System

1. Launch the software by clicking Programs from the Start menu and selecting KODAK MI.exe from the KODAK MI menu (Windows) or by clicking on the KODAK MI icon found in the KODAK MI folder (Macintosh). The project window appears.

2. Choose Select Digital Camera from the File menu. Choose the KODAK Imaging System that you are using from the Digital Camera pop-up menu. The software systematically searches the appropriate computer port(s). If the selected imaging device is not found, one of several messages will appear on-screen depending upon the imaging system selected.

   ✔ If a KODAK Gel Logic 100 System is not found, a message appears stating Error Connecting with the Camera. Ensure that Image Station or GL System is properly connected and powered ON, and that the proper Imaging System was selected in the Digital Camera pop-up menu.

3. Once a device is found, the File menu and the Status bar Camera Access buttons reflect the current selection.

4. If no camera is found, the Select Digital Camera dialog box appears, allowing you to reselect the camera.

![Select Digital Camera dialog box](image-url)
5 Use the Digital Camera pop-up menu to select your camera.

<table>
<thead>
<tr>
<th>GL 100/GL 200</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>IS4000MM</td>
<td></td>
</tr>
<tr>
<td>IS4030R</td>
<td></td>
</tr>
<tr>
<td>IS2000MM</td>
<td></td>
</tr>
<tr>
<td>IS2000R</td>
<td></td>
</tr>
<tr>
<td>IS1000</td>
<td></td>
</tr>
<tr>
<td>IS44DC/G44D</td>
<td></td>
</tr>
<tr>
<td>GL 100/GL 200</td>
<td></td>
</tr>
<tr>
<td>DC 200</td>
<td></td>
</tr>
</tbody>
</table>

6 Click OK. The Project window appears. Your installation is complete.

NOTE: If you fail to communicate, contact KODAK Technical Support for further assistance.

7 Your hardware setup and software installation are now complete. To learn about capturing images with the GL 100, proceed to Chapter 4: Capturing Images.
Capturing Images

Once your KODAK Gel Logic 100 (GL 100) imaging system has been set up and KODAK Molecular Imaging Software (KODAK MI Software) is installed, you are ready to capture high quality digital images.

✔ Using GL 100, you can document your laboratory experiments with floating point accuracy and analyze images:
  • DNA, RNA and protein electrophoresis gels, including gels stained with ethidium bromide, SYPRO Orange, SYBR Green, SYBR Gold, and Coomassie Blue
  • Microtiter plate assays
  • Colony plates
  • Plaque screening
  • Thin-layer chromatography plates

✔ Generate a quick print of your image.

✔ Annotate, analyze, and database your images.
Capturing Images Using Gel Logic 100 Acquire Software

If you have not yet set up your system and installed KODAK MI Software, see Chapter 2: Setting Up Your System.

Launching KODAK MI and the GL100 Acquire Software

If you have already launched your software and opened the GL 100 Acquire window, proceed to the next section, Preparing for Image Capture.

1 Launch the software by clicking Programs from the Start menu and selecting KODAK MI.exe from the KODAK MI menu (Windows) or by clicking on the KODAK MI icon found in the KODAK MI folder (Macintosh). The project window appears.

2 Choose Select Digital Camera from the File menu. Choose the KODAK Imaging System that you are using from the Digital Camera pop-up menu. The software systematically searches the appropriate computer port(s). If the selected imaging device is not found, one of several messages will appear on-screen depending upon the imaging system selected.

3 Once a device is found, the File menu and the Status bar Camera Access buttons reflect the current selection.
4 If no camera is found, the Select Digital Camera dialog box appears, allowing you to reselect the camera.

![Select Digital Camera dialog box]

5 Use the Digital Camera pop-up menu to select your camera.

![Digital Camera pop-up menu]
6 Click OK. The Acquire window appears.

NOTE: If you fail to communicate, contact KODAK Technical Support for further assistance.
Preparing for Image Capture

The GL 100 systems can be used with UV or white light transillumination. Your GL 100 should be installed, if it is has not yet been installed, see Chapter 3: Setting up the System.

UV or White Light Transillumination

Be sure that your light table surface is clean prior to any sample placement. Dust, particles or scratches on the surface may introduce artifacts in your data. Extra care should be taken when cleaning the surface to avoid scratches.

1. Open the Imaging Cabinet Door.
2. Wipe the light table with a lint-free soft cloth or damp paper towel.
   - **NOTE:** Special care should be taken if your sample is dry. Assure a dry surface by a quick ethanol wipe.
   - **NOTE:** Do not use metal utensils or tweezers since they may scratch and permanently damage the glass surface.
3. Select the appropriate framing mask insert for your sample size, insert it into the imaging cabinet through the open door, and nest it inside the larger mat on the light table.
   - **NOTE:** If you are interested in imaging only a small portion of your sample, you may want to choose a smaller size and optically zoomed in during image capture.
4 Choose an optical filter appropriate for your application using the table below:

<table>
<thead>
<tr>
<th>Filter (nm)</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>NONE</td>
<td>coomassie gels, autorad film</td>
</tr>
<tr>
<td>670</td>
<td>acrydine orange-RNA</td>
</tr>
<tr>
<td>590</td>
<td>ethidium bromide, ruby red, texas red, ruby orange</td>
</tr>
<tr>
<td>570</td>
<td>Pyronin Y</td>
</tr>
<tr>
<td>535</td>
<td>SYBR Gold, SYBR Green, Fluorescein, Rhodamine, Eosin, acrydine orange-DNA</td>
</tr>
<tr>
<td>435</td>
<td>DAPI, syto blue</td>
</tr>
</tbody>
</table>

5 Place the appropriate filter in the Active Location slot in the Filter Slider.

NOTE: Store filters when not in use in the extra slots on the Filter Slider to protect them from damage

6 Proceed to *Capturing Images*, later in this chapter.
Capturing Images

The GL 100 supports several image capture methods including single capture exposure, multiple capture exposure (accumulated into a single file or as separate files) and time lapse exposures. Using these exposure modes, the minimum and maximum exposure times are 0.001 second and 16 seconds, respectively.

The Preview mode offers you a way to view what the camera will image. In preview mode you can optimize the sample placement, aperture, zoom and exposure time. The Preview button initiates the “live” stream of single capture images. The Progress bars and Elapsed Time text become active providing feedback on the current capture.

1. Select your illumination type from the Type pop-up menu—the exposure time defaults to a typical exposure time.

✓ UV Transillumination is ideal for providing illumination for fluorescently stained images (i.e., ethidium bromide, SYBR green).

✓ White Light Transillumination is also ideal for opaque samples (plates and visible dye stained gels).

✓ The Time Lapse Exposure option is designed to take multiple exposures over fixed time intervals. If you selected Time Lapse, proceed to Capturing Time Lapse Images, later in this chapter.

✓ The Custom option provides you a way to define your own type.
Depending on your selection, the default exposure times are:

<table>
<thead>
<tr>
<th>Type</th>
<th>Default Exposure Setting</th>
<th>Working f-stop Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>UV Transillumination</td>
<td>3 seconds</td>
<td>f/4 to f/6</td>
</tr>
<tr>
<td>White Light Transillumination</td>
<td>0.005</td>
<td>f/6 to f/10</td>
</tr>
</tbody>
</table>

2 Click the Show Saturation checkbox.
3 Set the aperture of the lens to f-stop 1.2 (top camera ring).
4 Click the preview button. A preview appears in the GL 100 window.

5 If the pixels are saturated (displayed in red on screen), adjust the aperture down (increase the f-stop) and/or adjust the exposure time using the Exposure Time text edit box until the red pixels are no longer visible on screen.

The minimum and maximum exposure times are 0.001 second per exposure and 16 seconds per exposure, respectively. The time units can be set as seconds or minutes. The minimum increment is 0.001 seconds for short exposures.
NOTE: The f-stop or lens aperture determines the amount of light that passes through the lens, while the exposure time controls how long the CCD is exposed. You will improve resolution using a higher f-stop (smaller apertures), but signal is reduced requiring a longer exposure time.

The f-stop and exposure time are used to optimize the exposure. It is best to find a f-stop and exposure time that provides a single frame with pixels just below saturation to maximize dynamic range and increase sensitivity. Remember as exposure time increases, more noise (random background) is introduced. Exposure times longer than 10 seconds are not recommended.

6 Using the middle Zoom ring on the camera lens to fill the entire frame with the sample image or features of interest. This maximizes the number of pixels within your sample image.

NOTE: The Zoom setting relates directly to the image resolution. The GL 100 CCD has a pixel resolution of 1280 x 960 pixels. At the smallest field of view (48 mm), the number of pixels are spread over a 3.5 x 4.7 cm area producing a resolution of ~272 pixels/cm. At the largest field of view setting (8 mm), the pixels are spread over a 20 x 27.5 cm area (46 pixels/cm). An important consideration is the number of pixels that are applied to the smallest feature of interest.

7 If the preview is out of focus use the Focus ring (bottom ring) to adjust the focus.

NOTE: If you have problems focusing, a software assisted focusing tool can be used. See Using the Focusing Tool, later in this chapter.

8 Record the value using the Zoom slider at the bottom of the acquire menu to ensure proper size calibration of the final image.

9 To capture an image—either as a project or just as a print you have several options:

✔ For a single exposure that you want opened as a project, click on the Capture button

✔ If you do not want to save the file and just want a print out of a single capture, click the Quick Print button. The image goes directly to the default printer and no image is saved to disk.
✔ For multiple exposures, click the Stop Preview button and then enter the number of exposures that you would like to capture in the No. Exposures text edit box or select the number of exposures from the pop-up menu.

No. Exposures: 2

Click either the Capture or Quick Print button.

✔ For time lapse exposures, click Stop Preview. The interval and Stop after text edit boxes are activated. Enter an interval (time interval between the beginning of one exposure and the beginning of the next exposure) in the Interval text edit box. The minimum and maximum intervals are 5 seconds and 24 hours, respectively. Define when to stop the exposures using the Stop After text edit box. You can set stop criteria based on experimental duration or by the number of frames. The maximum time is 24 hours and the maximum number of frames is 100.
Custom Capture Settings

You can speed up the capture process by creating custom capture settings for the various types of experiments or specific personal preferences. Once saved, the camera settings are remembered which include:

✔ Type
✔ Exposure time
✔ Number of exposures
✔ Illumination correction
✔ Zoom settings
✔ Image orientation
✔ Preferences selections
✔ Saturation levels

⚠️ IMPORTANT: Settings will NOT save the User Name or Annotations.

Saving Custom Settings

1 Make all your selections from within the Gel Logic window.
2 Choose the Save Settings from the Settings pop-up menu. A File Name dialog box appears.
3 Enter a name to describe your custom settings.
4 Click OK. The settings are saved and will appear in the list of available settings.

⚠️ NOTE: If you choose a custom acquire setting, and then make modifications to the custom settings, they will not be saved unless you update the custom setting by selecting Updating Settings from the Settings pop-up menu.

⚠️ NOTE: Custom settings will be saved as individual files in the
MacintoshHD>Applications>KODAK MI>Kodak MI Extensions>GL 100_Settings (Macintosh) or C: Program Files>Kodak MI>MI Application>GL_100>GL_100 Settings (Windows) subfolders.
Updating Custom User Settings

1. Select a custom setting from the Settings pop-up menu.
2. Modify settings as desired.
3. Choose Update Settings in the Settings pop-up menu.

☞ NOTE: The GL 100 factory defaults cannot be updated.

Deleting Custom User Settings

1. Select a custom setting from the Settings pop-up menu.
2. Choose Delete Settings.

☞ NOTE: The GL 100 factory defaults cannot be deleted.
Using the Focusing Tool

The GL 100 Imaging Cabinet has been designed to maintain the proper focal distance from the camera to your sample to minimize the need to focus. If you should need to adjust the focus, use the Focus Ring (bottom ring).

If your samples vary in thickness, the software-assisted focusing tool is available in the Preview mode for use. The software determines camera focus by using the sharpness of edges within the image. To adjust focus:

1. Place your sample in the Imaging Cabinet.
2. Click Preview.
3. Adjust the exposure time and f-stop to best represent your image in the Preview.
4. Adjust the Zoom to fill your field of view with the sample.
5. Place a ruler or any sharp edged flat object on top of your sample.
6. Click the Focus Camera checkbox. A selection rectangle will appear on screen, in the center of the image.
7. Adjust the Focus ring to maximize the numerical value appearing in the text box.
   - Increasing values indicate focus is sharpening, whereas, decreasing values indicate blurring of the image.
   - A green or red indicator light provides a visual indicator. As you are improving focus the indicator light signals green. Moving the focus in the wrong direction, the indicator light signals red.
8. To exit the Focusing mode, uncheck the Focus Camera.
Applying an Illumination Reference File

Improve the quality of your data by applying field illumination correction to images captured. The illumination non-uniformity is highly reproducible and may be corrected by dividing the sample image by an illumination reference image. It is important to capture a reference image of the illumination field using the same camera settings (f-stop, zoom) used at the time you are capturing the image to be corrected.

1 Prior to capturing the image select the Illumination Reference checkbox.
2 Capture an image as described in Capturing Images, earlier in this chapter.

NOTE: Do not adjust the f-stop, zoom, exposure time, or placement of the Epi-Illumination pads.
3 Upon completion of the capture the illumination correction dialog box appears.
4 Remove the sample from the imaging cabinet and clean the surface.
5 Enter a name in the Output name text edit box.
6 Click Continue. The illumination reference is applied and the output file opens as a new project.

You can not do a illumination reference correction if you have saturated pixels in your images.
Adding an Annotation Bar to the Printed Image

You can tag your image with an Annotation bar which contains the time and date of the capture of the image, the exposure setting, sample type, and up to 48 characters of text. The text will appear on the long axis at the top of the image in 12 point Helvetica Bold as white text on a black background.

- **NOTE:** All items in the Annotation bar are separate objects and are displayed in the Annotations window. You can change the font style, color, or size prior to printing, however, the items are grouped. You must ungroup the items prior to editing.

1. Select the Add Annotation checkbox prior to taking a picture.

2. Type text (up to 48 character) in the Add Annotation text edit box.

3. The Annotations bar is appended to the image upon printing.

- **NOTE:** Each time you take a picture the Add Annotation text edit box will be cleared.

- **NOTE:** You can display or hide the Annotation bar by selecting the Show/Hide Annotation bar from the Annotations panel.
Maintaining Your System

Maintaining your KODAK Gel Logic 100 Camera Assembly

Your KODAK Gel Logic 100 (GL 100) Camera Assembly is a delicate piece of photographic equipment, requiring care and maintenance.

✔ To keep from damaging your GL 100 Camera Assembly, avoid exposure to moisture and extreme temperatures.
✔ Avoid touching the camera lens and close-up lens with your finger.
✔ Clean the outside of the GL 100 Camera Assembly by wiping it with a clean, dry cloth.

☞ WARNING: Never use harsh or abrasive cleaners or organic solvents on the camera lens or any of its parts.
✔ Do not disassemble the GL 100 Camera Assembly. This will void your warranty and could result in electrical shock.
✔ When cleaning your KODAK Gel Logic 100, we recommend that you wear impervious gloves, e.g. latex or nitrile.

Cleaning the Camera Lens, Close-Up Lens, and Filter

1 Wipe gently with a soft, lint-free cloth or an untreated lens-cleaning tissue.

☞ WARNING: Do not use cleaning solutions unless they are designed specifically for camera lenses. Do not wipe the camera lens with chemically treated eyeglass lens tissue because it may scratch the lens.

☞ Follow instructions noted in the MSDS while handling or using ammonia based spray cleaner.
Maintaining your KODAK GL 100 Imaging Cabinet

The GL 100 Imaging Cabinet is fabricated to facilitate easy cleaning. We recommend that you clean your cabinet and accessories regularly to keep them in good working order.

Cleaning the GL 100 Imaging Cabinet

The GL 100 Imaging Cabinet is designed for easy care. Prior to cleaning, make sure that the GL 100 Camera Assembly has been removed from the cabinet.

✔ For material not contaminated with biological or radiological substances, wipe with a non-abrasive cleaner.

✔ Follow instructions noted in the MSDS while handling any cleaners.

✔ For materials contaminated with biological substances, prepare a 5% bleach solution in water. Wipe down the cabinet with the bleach solution using a clean cloth or sponge. Wipe clean with water.

✔ For materials contaminated with radiological substances, decontaminate with a radioactive decontamination detergent, following manufacturer’s instructions and your institutional safety protocols for decontaminating and handling radioactive waste.

✔ To dry, use a soft cloth, paper towel or allow to air dry.

Cleaning the Framing Masks

The Framing Masks are easy to clean:

✔ For material not contaminated with biological or radiological substances, the masks may be washed with a non-abrasive detergent and rinsed with deionized water.

✔ For materials contaminated with biological substances, prepare a 5% bleach solution in water. Wipe down the masks with the bleach solution using a clean cloth or sponge. Rinse thoroughly with deionized water.

✔ For materials contaminated with radiological substances, decontaminate with a radioactive decontamination detergent following manufacturer’s instructions and your institutional safety protocols for decontaminating and handling radioactive waste.

✔ To dry, use a soft cloth, paper towel or allow to air dry.
Troubleshooting the System

In this chapter, common questions are addressed. The questions are divided into three sections: Instrument, Image, and Software. If you still have questions after reading this section and the corresponding information in the User’s Guide, contact Technical Support. Please have your serial number and any technical information available.
Technical Support

Contact Kodak Technical Support or your Molecular Imaging Systems dealer. For up to date dealer information, visit our WEB site at www.kodak.com/go/scientific. When contacting technical support, please have the following information available:

✔ The serial number and version number of your KODAK Software.

NOTE: With the software running, select About KODAK MI under the Help menu (Windows) or select About KODAK MI under the Apple menu item (Macintosh).

✔ The type of computer you are using (make, model and operating system version).

NOTE: Check your operating system version by right-clicking on the My Computer icon and then on Properties (Windows) or select About This Mac under the Apple menu item (Macintosh).

✔ The problem you are having and what you were doing when the problem occurred. Please note the exact wording of any error messages, including any error numbers displayed.

When contacting technical support by telephone, you will be assisted best if you are seated in front of your computer with KODAK MI Software running.

Kodak Molecular Imaging Systems Technical Support

Contact Kodak Molecular Imaging Systems Technical Support by:

✔ Utilizing our World Wide Web support pages at:
  http://www.kodak.com/go/scientific

✔ Calling Kodak Molecular Imaging Systems Technical Support toll free at:
  877-747-4357, between the hours of 8:00 a.m. and 6:00 p.m. (Eastern Standard Time) Monday through Friday

✔ E-mailing Kodak Molecular Imaging Systems Technical Support at:
  kmi-support@kodak.com

✔ Faxing Kodak Molecular Imaging Systems Technical Support at:
  203-786-5656
## Common Instrument Questions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Probable Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot access the camera capture system.</td>
<td>Camera/Computer Interface Cable is not properly connected</td>
<td>Check the connections on the back of the GL 100 and the computer.</td>
</tr>
<tr>
<td></td>
<td>The Camera/Computer Interface Cable that came with the system was not used</td>
<td>Make sure that the FireWire cable being used is the one you received with your GL 100.</td>
</tr>
<tr>
<td></td>
<td>No power to the Camera.</td>
<td>Verify that the port is a 6-pin IEE 1394 (FireWire).</td>
</tr>
</tbody>
</table>
## Common Image Questions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Probable Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image is black or too dark.</td>
<td>Not enough light for a good contrast exposure.</td>
<td>Increase the f-stop (decrease number for more light). or increase the exposure time. See Chapter 4: Capturing Images.</td>
</tr>
<tr>
<td>Image is white or too light.</td>
<td>Too much light during the exposure.</td>
<td>Close down the f-stop (larger number for less light). See Chapter 4: Capturing Images.</td>
</tr>
<tr>
<td>Image is blurred.</td>
<td>Image is not in focus.</td>
<td>Adjust the Focus Ring and/or increase the depth of field by increasing the f-stop setting.</td>
</tr>
<tr>
<td></td>
<td>Dirty or cracked filter.</td>
<td>Capture an image with a different filter selected.</td>
</tr>
<tr>
<td></td>
<td>Contaminated optics.</td>
<td>Contact Technical Support.</td>
</tr>
<tr>
<td>Image appears with many speckles in a UV illuminated image.</td>
<td>Dust or dirt on the Platen.</td>
<td>See Preparing for Imaging in Chapter 4: Capturing Images.</td>
</tr>
<tr>
<td>Image partially blocked.</td>
<td>Filter not centered over the lens properly.</td>
<td>Check that the Filter Selection Dial is lined up with the filter selection properly. View the Filter Wheel alignment by looking down into the Platen.</td>
</tr>
<tr>
<td>Lines on the image.</td>
<td>Scratched Platen.</td>
<td>Contact Technical Support for further instructions.</td>
</tr>
<tr>
<td>The background intensity of the image is uneven in the Project window.</td>
<td>Improper Illumination Reference File was used for correction.</td>
<td>Be sure the proper Illumination Reference File is used. See Applying an Illumination Correction in Chapter 4: Capturing Images.</td>
</tr>
<tr>
<td>The image is not the correct size.</td>
<td>f-stop and Zoom settings used for submitting the image are not the same as those used to capture the image.</td>
<td>Be sure the proper f-stop and Zoom inputs are used. See Applying an Illumination Correction in Chapter 4: Capturing Images.</td>
</tr>
</tbody>
</table>
## Common Software Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Probable Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error # 10005</td>
<td>The copy protection device is not found.</td>
<td>Connect the copy protection device and restart your computer.</td>
</tr>
<tr>
<td>Error # 11001</td>
<td>The copy protection device is configured for a newer version of KODAK MI Software.</td>
<td>You are using an older version of KODAK MI Software, you may want to use a newer version instead.</td>
</tr>
<tr>
<td>Error # 11002</td>
<td>The copy protection device is from an older version of KODAK MI Software.</td>
<td>Shut down your computer and attach the copy protection device that came with the newest version of KODAK MI Software. Restart your computer.</td>
</tr>
<tr>
<td>Error # 12002</td>
<td>A new copy protection device was expected, but not found.</td>
<td>Shut down your computer and attach the copy protection device that came with the newest version of KODAK MI Software. Restart your computer.</td>
</tr>
<tr>
<td>Error # 12003</td>
<td>The copy protection device was disabled during the upgrade process.</td>
<td>Shut down your computer and attach the upgrade copy protection device that came with the upgrade package. Restart your computer. Return the disabled copy protection device to Kodak for recycling.</td>
</tr>
<tr>
<td>Error #12004</td>
<td>Upgrading your KODAK MI Software requires both your existing and new copy protection devices.</td>
<td>Connect both your existing copy protection device and the upgrade copy protection device together, connect to your computer and restart the computer.</td>
</tr>
<tr>
<td>My Macintosh computer is going to sleep mode.</td>
<td>System/Display sleep mode set incorrectly.</td>
<td>Under Control Panel/Energy Saver, set the sleep setting to Never.</td>
</tr>
</tbody>
</table>
Warranty

Warranty Time Period

Kodak warrants the KODAK Gel Logic 100 Imaging System (GL 100) to be free from malfunctions and defects in both materials and workmanship for one year from the date of purchase. If a computer was purchased with the GL 100 system, it is covered under separate warranty provided by the computer manufacturer.

Days and Hours of Coverage

Arrangements for service through Kodak Technical Support can be made Monday through Friday 8:00 a.m. to 6:00 p.m. EST in the United States, except for locally observed holidays. Hours of coverage outside the United States may vary. Contact your local Kodak Molecular Imaging Systems dealer for hours of coverage.

Warranty Repair Coverage

If the equipment does not function properly during the warranty period due to defects in either materials or workmanship, Kodak will, at its option, either repair or replace the equipment without charge, subject to the conditions and limitations stated herein. Such repair service will include all labor as well as any necessary adjustments and/or replacement parts.

If replacement parts are used in making repairs, these parts may be remanufactured, or may contain remanufactured materials. If it is necessary to replace the entire system, it may be replaced with a remanufactured system.

Kodak will also provide telephone assistance during the warranty period.

Limitations

WARRANTY SERVICE WILL NOT BE PROVIDED WITHOUT DATED PROOF OF PURCHASE. PLEASE RETURN THE WARRANTY REGISTRATION CARD WITHIN 30 DAYS OF PURCHASE.
THIS WARRANTY BECOMES NULL AND VOID IF YOU FAIL TO PACK YOUR INSTRUMENT IN A MANNER CONSISTENT WITH THE ORIGINAL PRODUCT PACKAGING AND DAMAGE OCCURS DURING PRODUCT SHIPMENT.

THIS WARRANTY DOES NOT COVER: CIRCUMSTANCES BEYOND KODAK'S CONTROL; SERVICE OR PARTS TO CORRECT PROBLEMS RESULTING FROM THE USE OF ATTACHMENTS, ACCESSORIES OR ALTERATIONS NOT MARKETED BY KODAK; SERVICE REQUIRED AS THE RESULT OF UNAUTHORIZED MODIFICATIONS OR SERVICE; MISUSE, ABUSE; FAILURE TO FOLLOW KODAK'S OPERATING, MAINTENANCE OR REPACKAGING INSTRUCTIONS; OR FAILURE TO USE ITEMS SUPPLIED BY KODAK (SUCH AS ADAPTERS AND CABLES).

KODAK MAKES NO OTHER WARRANTIES, EXPRESS, IMPLIED, OR OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE FOR THIS EQUIPMENT OR SOFTWARE.

REPAIR OR REPLACEMENT WITHOUT CHARGE ARE KODAK'S ONLY OBLIGATION UNDER THIS WARRANTY. KODAK WILL NOT BE RESPONSIBLE FOR ANY SPECIAL, CONSEQUENTIAL OR INCIDENTAL DAMAGES RESULTING FROM THE PURCHASE, USE, OR IMPROPER FUNCTIONING OF THIS EQUIPMENT REGARDLESS OF THE CAUSE. SUCH DAMAGES FOR WHICH KODAK WILL NOT BE RESPONSIBLE INCLUDE, BUT ARE NOT LIMITED TO, LOSS OF REVENUE OR PROFIT, DOWNTIME COSTS, LOSS OF USE OF THE EQUIPMENT, COST OF ANY SUBSTITUTE EQUIPMENT, FACILITIES OR SERVICES, OR CLAIMS OF YOUR CUSTOMERS FOR SUCH DAMAGES.

Depending on your geographical location, some limitations and exclusions may not apply.
How to Obtain Service

If the instrument does not function properly during the warranty period, contact Kodak or your local Kodak dealer to arrange for service. If your unit needs to be returned for any reason, please contact your local Kodak dealer to obtain a return authorization. All returned units must be decontaminated prior to their return, as described below. No returns will be accepted without a return authorization and proper decontamination documentation.

When contacting technical support, please have the following information available:

✔ The serial number and version number of your KODAK Software.

☞ NOTE: With the software running, select About KODAK MI under the Help menu (Windows) or select About KODAK MI under the Apple menu item (Macintosh).

✔ The type of computer you are using (make, model and operating system version).

☞ NOTE: Check your operating system version by right-clicking on the My Computer icon and then on Properties (Windows) or select About This Mac under the Apple menu item (Macintosh).

✔ The problem you are having and what you were doing when the problem occurred. Please note the exact wording of any error messages, including any error numbers displayed.

When contacting technical support by telephone, you will be assisted best if you are seated in front of your computer with KODAK MI Software running.

Contact Kodak Molecular Imaging Systems Technical Support by:

✔ Utilizing our World Wide Web support pages at:
   http://www.kodak.com/go/scientific

✔ Calling Kodak Molecular Imaging Systems Technical Support toll free at:
   877-747-4357, between the hours of 8:00 a.m. and 6:00 p.m. (Eastern Standard Time) Monday through Friday

✔ E-mailing Kodak Molecular Imaging Systems Technical Support at:
   kmi-support@kodak.com

✔ Faxing Kodak Molecular Imaging Systems Technical Support at:
   203-786-5656

For up-to-date dealer information, visit our WEB site at www.kodak.com/go/scientific.
General Instructions for Cleaning and Decontamination For Return of the KODAK Gel Logic 100

All returned material must be cleaned and decontaminated prior to shipping. To meet Federal and State Regulatory and Safety standards, please follow the decontamination procedure given here if radioactive materials are used with this product or are used in the vicinity of where this apparatus has been used or stored.

General Cleaning Procedure

For materials not contaminated with biological or radiological substances, components may be gently washed using water or an ammonia based spray cleaner using soft lint-free cloth or lens paper.

WARNING: Do not expose Platen to strong chemical solvents such as ketones and hexanes. This may permanently damage the Platen and will void your warranty.

Radiological Decontamination Procedure

WARNING: We cannot accept return of products which are contaminated with any radioactivity.

For beta emitting isotopes such as $^{32}$P, use a GM-type radioactivity meter calibrated in counts per minute (CPM) to determine the background readings for your work area. Wearing latex gloves, survey the unit to be returned with the GM meter. If any part of the unit is found to show readings higher than background, wash the area using Count Off™ (PerkinElmer Life Sciences) or another similar commercially available detergent and paper towels. If none are available, a Formula 409™-like solution or a mild detergent will do. As you clean, discard liquid and solid waste (gloves and paper towels) according to your local and institutional regulations for radioactive material disposal. Continue washing until the GM meter reading for the contaminated area(s) is equal to or below background.

To decontaminate units where a GM-meter is not useful for detection, such as with $^{3}$H or $^{35}$S, it will be necessary to perform swipes of the unit and detect using a scintillation counter. The unit should be dry. Wipe surfaces with dry paper circles (these are commercially available or you can make your own). Areas can be charted, so that individual swipes can be done on different surfaces to better isolate areas of contamination. These swipes are then placed into individual scintillation vials with an
appropriate fluor and then analyzed on a properly programmed scintillation counter. If contamination above 100 disintegrations per minute dpm/100 cm$^2$ (dpm = CPM/efficiency) is found, wash the area as described above for beta emitting isotope decontamination. After cleaning the area, swipe it a second time to determine the amount of contamination remaining. If the area still has a greater than 100 dpm/cm$^2$, continue the cycle of swipes and washing until you achieve a reading of less than 100 dpm/cm.$^2$.

Once the unit has been determined to be radiation free (< 100 dpm/cm$^2$), remove all the hazardous and radioactive labels from the unit. If the labels cannot be removed, deface them. Failure to do so may result in significant delay or a refusal of repair.

If your unit has unremovable decontamination (detectable with a GM-meter and not with paper swipes, or detectable with paper swipes but after continued washing the dpm/cm$^2$ remains constant above 100) of a short half life isotope such as $^{32}$P, the unit may be stored for 10 half lives of isotopic decay and the decontamination procedure repeated.

NOTE: Units contaminated with unremovable, long half life isotopes may not be returned.

Repackaging the Gel Logic 100

Inappropriate packing will void the Gel Logic 100 warranty. Follow these directions when packing the Gel Logic 100 for shipment.

1. Decontaminate the Gel Logic 100 as described above.
2. Remove the power cord and Camera/Computer Cable from the Gel Logic 100.
3. Unscrew the Camera Assembly from the imaging cabinet.
4. Package the Camera Assembly in foam padding.
5. Secure the Filter slider to the imaging cabinet with masking tape.
6. Place the components 100 in its original plastic bag.
7. Pack the Gel Logic 100 in its original box. If you have discarded the original packing material, call Technical Support to arrange for delivery of new packing material.
Regulatory Information

“This equipment has been tested and found to comply with the limits for a Class A digital device pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

This Class A digital apparatus meets all requirement of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.”

For Use in European Union

WARNING

This is a class A product. In a domestic environment this product may cause radio interference in which case the user may be required to take adequate measures.

For Use in Taiwan

警告使用者：
这是甲類的資訊產品，在居住的環境中使用時，可能會造成射頻干擾，在這種情況下，使用會被要求採取某些適當的對策。
Index

A
About the User Guide 1-2
Acquire Software
  installation 3-4—3-16
  launching 3-17—3-18, 4-2, 4-3
  Macintosh 3-11—3-16
  Preferences 2-16—2-18
  Windows 3-4—3-10
Acquire Window 2-6, 4-2—4-3, 4-7—4-12
  Buttons section 2-15
  Exposure section 2-10—2-13
  User section 2-8—2-9
  Zoom setting section 2-14
Annotations bar 2-9, 4-15

C
Cabinet, Imaging 2-4—2-5
Cable Connector, Camera 2-2—2-3, 3-10, 3-16
Camera
  About 2-2—2-3
  Assembly 2-2—2-3
  Cable Connector 2-2—2-3, 3-10, 3-16
  CCD 1-1, 2-2, 3-1
  computer interface cable 2-2—2-3, 3-10, 3-16
  f-Stop ring 2-2—2-3, 4-8—4-9
  Focus ring 2-2—2-3, 4-8—4-9
  installation 3-2
  Lens 2-2—2-3
Camera Cable Connector 2-2—2-3, 3-10, 3-16
Capture
  Images 4-1—4-16
  settings 2-8—2-9, 4-8—4-12
Charged-Coupled-Device (CCD) 1-1, 2-2, 3-1
Cleaning 5-1—5-2
Conventions, User’s Guide 1-2
Coomasse Blue 3-3, 4-6
Copy protection device 3-8, 3-14
Correction, illumination 2-12, 4-14
Custom Capture settings 2-8—2-9, 4-11—4-12

D
Deleting setting 4-12
Digital camera 2-2—2-3
  selecting 3-23—3-24, 4-2—4-3
Decontamination W4—W-5

E
Ethidium bromide 3-3, 4-6
Exposure 4-6—4-10
  Multiple 2-1
  Single 2-1
  Standard 2-10—2-12
  Time Lapse 2-1, 2-13

F
f-Stop
  range 3-1, 4-3
  ring 2-2—2-3, 4-8—4-11
File
  Capture 1-1, 2-1
  Illumination Reference 4-14
Filter
  435 nm 3-3, 4-6
535 nm 3-3, 4-6
570 nm 3-3, 4-6
590 nm 3-3, 4-6
670 nm 3-3, 4-6
applying 3-3, 4-6
choosing 3-3, 4-6
slider 2-4—2-5, 3-3, 4-6
FireWire camera cable connector 2-2—2-3, 3-9, 3-16
Focusing tool 4-13

H
Hardware
overview 2-2—2-5
setup 3-1—3-3

I
IEEE 1394 port 3-10, 3-16
Illumination
choosing 4-6
Reference File 2-12, 4-13
Trans 4-5—4-6
UV 4-5—4-15
Image
Capture Settings 2-10—2-14, 4-8—4-13
illumination correction 2-12, 4-14
orientation 2-17
saturation 2-11, 4-8
Imaging Cabinet
About 2-4—2-5
Setting up 3-2—3-3
Using 4-5—4-10
Installation
Hardware 3-1—3-3
Molecular Imaging Software 3-4—3-16

L
Lens 2-2—2-3, 3-1

Focusing 4-8, 4-12
f-stop 2-2—2-3, 4-7—4-8
Launching Kodak Software 3-17—3-22, 4-2—4-3

M
Macintosh
Requirements 1-5
Software installation 3-11—3-16
Maintenance 5-1—5-2
Molecular Imaging Software
installation 3-4—3-16
launching 3-17—3-22, 4-2—4-3
Macintosh 3-11—3-16
Preferences 2-16—2-18
Package contents 1-4
System requirements 1-5
Windows 3-4—3-10
Multiple exposures 2-1, 4-10

P
Preferences
dialog box 2-16—2-18
image capture 2-17
print 2-18
Preview 2-7, 2-15, 4-8—4-10

Q
Quick Print 2-7, 2-15, 4-9

R
Registering 1-7
regulatory information W-6
Repacking W-5
requirements, system 1-5

S
sample
orienting 2-17
Saturation 4-7—4-9
Saving settings 4-10
Single exposure 2-1
Software
  installation 3-4—3-16
  launching 3-17—3-22, 4-2—4-3
  Macintosh 3-11—3-16
  Preferences 2-16—2-18
  Package contents 1-4
  System requirements 1-5
  Windows 3-4—3-10
Standard capture 2-10—2-12, 4-7—4-9
Stop Preview button 2-15, 4-10
SYBR Green 3-3, 4-6
SYBR Gold 3-3, 4-6
SYPRO Orange 3-3, 4-6
System, GL 100
  components 1-4
  installation 3-1—3-16
  maintaining 5-1—5-2
  overview 1-1, 2-1—2-18
  registering 1-7
  regulatory information W-6
  repacking W-5
  requirements 1-5

U
  Updating settings 4-12
  User name option 2-6, 2-9, 4-11
  User’s Guide
    MI 1-2
    about the 1-2
    conventions 1-2
    navigating 1-3
  User section 2-6, 2-9, 4-1
  UV Illumination 4-5—4-6

W
  warranty W1—W-5
    coverage W-1
    decontamination W-4—W-5
  Limitations W-2
  registration 1-7
  Regulatory W-6
  service W-3
  time period W-1
  White light transillumination 4-5—4-6
  Windows
    requirements 1-5
    software installation 3-4—3-10

T
  Technical Support 1-6, 6-2, W-1, W-3
  Time lapse exposure 2-1, 2-13, 4-7—4-10
  Troubleshooting 6-1—6-5

Z
  Zoom
    Ring 2-2—2-3, 4-8
    Setting 2-14